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1 Introduction 

This user manual provides information using the GRL PCIe3-BASE & PCIe4-BASE (8 GT/s) Rx test 
automation solution, GRL-PCIE4-BASE-RXA to set up and test an electrical receiver (Rx) device to 

meet PCI Express Base compliance at 8 GT/s as per PCI Express (PCI-SIG) Standards. 

The main body of this documentation first describes how to configure the GRL-PCIE4-BASE-RXA 
test software to calibrate the stressed eye at the receiver of the device under test (DUT) in a PCIe 

Gen 3.0 (8 GT/s) system. This includes calibration to be performed at the following test points: 

TP1, TP2, and TP2P. The GRL software will automate calibration without channel effect at TP1 
before measuring the eye opening due to trace length at TP2. The software also supports PCI-SIG 

Seasim application to perform calculation for TP2P to simulate the eye opening after applying Rx 

Behavioral package, Rx CTLE, and DFE (if required). 

After completing calibration, the GRL software will automate compliance testing for the receiver 
using Bit Error Ratio (BER) as a metric. The receiver path is tested with worst case eye to ensure a 

BER of less than 1E-12 can be achieved. The signal used to measure receiver tolerance should 

include the maximum allowable jitter, noise, and signal loss. The receiver tolerance test includes 
various differential mode sinusoidal interference, minimum transmitter voltage amplitude, and 

jitter which includes random jitter including a sinusoidal periodic jitter component that is swept 

across specific frequency intervals. The GRL software also provides an optional stress margin 
search test for the DUT. 

The GRL-PCIE4-BASE-RXA software performs test automation according to PCI-SIG-approved 

Methods of Implementation (MOI’s) using a high performance real-time oscilloscope, Anritsu BERT 

signal generator and error detector, and a compliant variable ISI generator. The GRL software is 
run from the computer or oscilloscope to provide automation control to test the DUT for PCIe Gen 

3.0 Base Rx electrical compliance. When combined with a satisfactory level of interoperability 

testing, these tests provide a reasonable level of confidence that the DUT’s will function properly 
in most PCIe environments.  

Note: See Appendix of this documentation for test methodology example using automation or refer 

to PCI-SIG for approved Method of Implementation (MOI’s) as technical reference. 

 

1.1 Reference Documents 

[1] PCI Express Base Specification, Rev. 3.1a, December 7, 2015 

[2] PCI Express Base Specification, Rev. 4.0, Version 1.0, September 27, 2017 

Note: The most current versions of above documents and ECNs are available to PCI-SIG Working 

Group members at: http://www.pcisig.com/specifications/pciexpress/ 

http://www.graniteriverlabs.com/
http://www.pcisig.com/specifications/pciexpress/
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2 Resource Requirements 

Note: Equipment requirements may vary according to the lab setup and DUT connector type. Below 
are the recommended lists of equipment for the typical test setup. 

2.1 Equipment Requirements 

TABLE 1. EQUIPMENT REQUIREMENTS – SYSTEMS 

System Qty. Description/Key Spec Requirement 

Keysight/Tektronix High Performance 
Real-time Oscilloscope [a] 

1 ≥ 20 GHz bandwidth [b], with Windows 7+ OS and 
DPOJET (Jitter and Eye Analysis Tools) software 

Anritsu MP1900A BERT 1 MP1900A Signal Quality Analyzer, with following 

modules: 

• MU181000A/B 12.5 GHz Synthesizer 

• MU181500B Jitter Modulation Source 

• MU195020A 21G/32G bit/s SI Pulse Pattern 
Generator, or  

MU196020A 64.2G bit/s or 64.2G baud PAM4 

Pulse Pattern Generator [c] 

• MU195040A 21G/32G bit/s Error Detector, or 

MU196040B 58G baud PAM4 Error Detector 

• MU195050A Noise Generator 

ISI Generator 1 PCIe-4 Base Spec compliant Fixed or Variable ISI 

Channel [d] 

V(m) - K(f) Adapter 2 34VKF50A Coaxial Adapter, only required if using a 
PAM4 Pulse Pattern Generator 

Computer (laptop or desktop) 1 For automation control (Windows 7+ OS) 

[a] Oscilloscope with scope software requirements as specified in vendor specific MOI’s. For example, when 

using the Keysight Scope, scope software such as Keysight InfiniiSim / EZ-JIT / Serial Data Analysis / Serial 
Data Equalization that are required for testing and signal processing must be pre-installed on the Scope. 
Similarly, the Tektronix Scope shall be used with DPOJET (Jitter and Eye Analysis Tools) software for making 

measurements. 

[b] Oscilloscope with scope bandwidth as specified in vendor specific MOI’s. 

[c] The GRL-PCIE4-BASE-RXA software supports the NRZ or PAM4 signal. 

[d] The Artek CLE Model Series is supported for variable ISI generation. Refer to Appendix of this document for 

the Artek CLE Series driver installation procedure. 

http://www.graniteriverlabs.com/
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TABLE 2. EQUIPMENT REQUIREMENTS – CABLES 

Cable[a] Qty. 

SMA-to-SMA cables 2 

Coaxial cables 2 pairs 

Phase matched K-K coaxial cables 2 pairs 

[a] Based on the standard test configuration. May require more or less cables depending on the DUT connector 
type.  

2.2 Software Requirements 

TABLE 3. SOFTWARE REQUIREMENTS 

Software Description/Source 

GRL-PCIE3-BASE-RXA[a] Granite River Labs PCIe® 4.0 (16 GT/s and 8 GT/s) Base Specification 
Receiver Calibration and Test Automation Software – 

www.graniteriverlabs.com 

Included with Node Locked License to single oscilloscope or PC OS 

VISA (Virtual Instrument 

Software Architecture) API 
Software 

VISA Software is required to be installed on the controller PC running GRL 

PCIe Gen 3 Base Rx software. GRL’s software framework has been tested to 

work with all three versions of VISA available on the Market:  

1. NI-VISA: http://www.ni.com/download/ni-visa-17.0/6646/en/ 

2. Keysight IO Libraries: www.keysight.com (Search on IO Libraries)  

3. Tektronix TekVISA: www.tek.com (Downloads > Software > TekVisa) 

Seasim Seasim tool for post-process analysis of the captured waveform (Eye 

Opening simulation software at TP2P) – www.pcisig.com 

MX183000A Anritsu High-Speed Serial Data Test Software – For loopback BER testing of 

the PCIe Gen 3 Base Rx DUT. This software is located in the MP1900A BERT. 

[a] PCIe3-BASE and PCIe4-BASE will need to be installed to test at both 16 GT/s and 8 GT/s data rates. If the 
GRL-PCIE4-RXA test solution is purchased, the user will need to install the GRL-PCIE4-BASE-RXA and GRL-
PCIE4-CEM-RXA solutions included in the package to perform testing for PCIe4-BASE and PCIe4-CEM at 16 GT/s 

and 8 GT/s. 

 

 

 

 

 

http://www.graniteriverlabs.com/
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3 General Overview of PCIe Base Rx CTS Requirements 

This section extracts the general specifications from CTS to show the main differences between 
existing PCIe Base Rx data rates. 

(Note: It is recommended to refer to the latest PCI-SIG released CTS for full measurement details.)  

 

http://www.graniteriverlabs.com/
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4 Setting Up GRL-PCIE4-BASE-RXA Automation Software 

This section provides the procedures to start up and pre-configure the GRL-PCIE4-BASE-RXA 
automation software before running tests at 8 GT/s. It also helps users familiarize themselves with 

the basic operation of the software. 

Note: The GRL software installer will automatically create shortcuts in the Desktop and Start Menu 
when installing the software.  

To start using the software, follow the procedures in the following sections. 

4.1 Download GRL-PCIE4-BASE-RXA Software 

Download and install the GRL software as follows: 

1. If the GRL-PCIE4-BASE-RXA software is to be installed on a PC (where it is referred to as 

‘controller PC’), install VISA (Virtual Instrument Software Architecture) on to the PC where the 
GRL software is to be used (see Section 2.2). 

2. Download the software ZIP file package from the Granite River Labs support site. 

3. The ZIP file contains: 

• AnritsuPCIe3_0_BasePatternFilesInstallationxxxxxxxxxSetup.exe – Run this on the 
Anritsu Signal Quality Analyzer to install the test pattern setup files. 

• AnritsuPCIe3_0_BaseRxTestApplicationxxxxxxxxxSetup.exe – Run this on the 

controller PC or oscilloscope to install the GRL-PCIE4-BASE-RXA application. 

• AnritsuPCIe3_0_BaseRxTestScopeSetupFilesInstallationxxxxxxxxxSetup.exe – Run 
this on the oscilloscope to install the scope setup files. 

4.2 Launch and Set Up Software  

1. Once the software is installed, open the GRL folder from the Windows Start menu. Click on 

GRL – Automated Test Solutions within the GRL folder to launch the GRL software 
framework. 

 
FIGURE 1. SELECT AND LAUNCH GRL FRAMEWORK 

http://www.graniteriverlabs.com/
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2. From the Application→Rx Test Solution drop-down menu, select ‘Anritsu PCIe 3.0 Base Rx 

Test’ to start the PCIe 3.0 Base Rx Test Application. If the selection is grayed out, it means that 
your license has expired. 

 

FIGURE 2. START PCIE 3.0 BASE RX TEST APPLICATION 

3. To enable license, go to License→License Details. 

 

FIGURE 3. SEE LICENSE DETAILS 

a) Check the license status for the installed application. 

 

FIGURE 4. CHECK LICENSE FOR INSTALLED APPLICATIONS 

b) Activate a License: 

http://www.graniteriverlabs.com/
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• If you have an Activation Key, enter it in the field provided and select “Activate”. 

• If you do not have an Activation Key, select “Close” to use a demo version of the software 

over a free 10-day trial period. 

Note: Once the 10-day trial period ends, you will need to request an Activation Key to continue using 

the software on the same computer or oscilloscope. The demo software is also limited in its 

capability, in that it will only calibrate the maximum frequency for each data rate. Thus, the demo 

version cannot be used to fully calibrate and test a device. For Demo and Beta Customer License 
Keys, please request an Activation Key by contacting support@graniteriverlabs.com. 

4. Select the Equipment Setup icon  on the PCIe 3.0 Base Rx Test Application menu. 

5. Connect the Anritsu MP1900A BERT via LAN to the GRL automation control enabled Scope or 

PC. The BERT and MX183000A software can be connected using connection string formats 

similar to the following examples:  

• BERT: “TCPIP0::192.168.0.14::5001::SOCKET” or “192.168.0.14:5001”  

• MX183000A: “TCPIP0::192.168.0.14::5000::SOCKET” or “192.168.0.14:5000” 

Note the IP addresses listed above are only examples and should be changed according to the 

actual network connection being used. 

6. If using a Artek CLE Model Series as the ISI generator, connect via USB to the GRL automation 

control enabled scope/PC and enter the Controller Serial (COM) address of the ISI generator. 

Also refer to Appendix of this document on how to install the CLE Series. 

7. On the Scope or PC, obtain the network addresses for all the connected instruments from the 

device settings. Note these addresses as they will be used to connect the instruments to the 

GRL automation software. 

8. On the Equipment Setup page of the GRL PCIe 3.0 Base Rx Test Application, type in the address 
of each connected instrument into the ‘Address’ field. 

(Note: If the GRL software is installed on the Tektronix Scope, ensure the Scope is connected via 

GPIB and type in the GPIB network address, for example “GPIB8::1::INSTR”.)  

If the GRL software is installed on the PC to control the Scope, type in the Scope IP address, for 

example “TCPIP0::192.168.0.110::inst0::INSTR”. Note to omit the Port number from the 

address. 

(Note: If the GRL software is installed on the Keysight Scope, and if there is error in connection, 

type in the Scope IP address as “TCPIP0::192.168.0.4::5025::SOCKET”.) 

9. Then select the “lightning” button (       ) for each connected instrument.  

The “lightning” button should turn green (        ) once the software has successfully established 
connection with each instrument. 
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FIGURE 5. CONNECT INSTRUMENTS WITH GRL SOFTWARE 

(Note: Additional information for connecting the Keysight and Tektronix oscilloscopes to the PC is 
provided in the Appendix of this User Guide & MOI.) 

4.3 Pre-Configure Software Before Calibration/Testing 

Once all equipment is successfully connected from the previous section, proceed to set up the 
preliminary settings before going to the advanced measurement setup. 

4.3.1 Enter Test Session Information 

Select          from the menu to access the Session Info page. Enter the information as required for 

the test session that is currently being run. The information provided will be included in the test 

report generated by the software once tests are completed. 

• The fields under DUT Info and Test Info are defined by the user.  

• The Software Info field is automatically populated by the software.  

 
FIGURE 6. SESSION INFO PAGE 

4.3.2 Set Measurement Conditions 

Select          from the menu to access the Conditions page to set the conditions for calibration and 

testing. 
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Recommended procedure: 

• Step 1: When calibrating, select all required conditions and perform the calibration. 

• Step 2: Once calibration is completed and ready for testing, re-select the conditions that 
will be used for specific tests. 

SJ tab: Select SJ Frequencies as defined by the Specification for calibration or testing.  

 
FIGURE 7. SELECT SJ FREQUENCIES 
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5 Calibrating Using GRL-PCIE4-BASE-RXA 

The GRL-PCIE4-BASE-RXA test solution supports automated receiver calibration using the stressed 
eye method for PCIe Gen 3 base receivers at 8 GT/s. To perform calibration, the GRL software is 

run from the PC or oscilloscope to enable automation control for each step of pre and post 

processing measurement sequence. 

Calibration for the PCIe3-Base & PCIe4-Base (8 GT/s) Rx electrical specification will basically be 

performed at three test points: TP1, TP2 and TP2P. Test Point 1 (TP1) is a physical test point for 

calibration without the effect of breakout channel length. TP2 is a physical test point that will 
affect the eye opening due to trace length. TP2P is a test point calculated by the PCI-SIG Seasim 

application to simulate the eye opening after applying Rx Behavioral package, Rx CTLE, and DFE 

(if required). 

 
FIGURE 8. RX CALIBRATION BLOCK DIAGRAM FROM PCIE GEN 3 BASE SPECIFICATION 
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FIGURE 9. RX TEST SETUP SCHEMATIC FROM PCIE GEN 3 BASE SPECIFICATION 

5.1 TP2 Channel Calibration Insertion Loss 

The PCIe3-Base (8 GT/s) Rx Specification defines three types of calibration channel at TP2: None, 

Short and Long. The PCIe4-Base (8 GT/s) Rx Specification defines only the Long calibration 
channel at TP2. 

Defined by the following figure, each channel insertion loss must meet the mask depending on its 

channel type. Variable and programmable ISI injector is needed to simulate the trace length to 

achieve the target loss for each channel. 

 

FIGURE 10. CHANNEL INSERTION LOSS MASK BY CHANNEL TYPE FROM PCIE GEN 3 BASE SPECIFICATION 
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Insertion loss is measured by differentiating step response and performing the FFT of the resulting 

impulse response. The Seasim application provides the method to calculate the insertion loss 
given the step response. 

5.2 TP2P Post Processing Calibration 

TP2P calibration consists of two methods for calibrating the stressed eye ― one to determine the 
minimum eye height (voltage), and another for the minimum eye width (jitter). 

5.2.1 TP2P Stressed Voltage Calibration  

The configuration for calibrating a stressed voltage eye for Rx testing is shown below where the 

calibration procedure is performed for all calibration/breakout channel combinations. RJ and SJ 
are added as defined below and common mode and differential mode noise sources are added 

simultaneously. 

 
FIGURE 11. RX STRESSED VOLTAGE EYE CALIBRATION BLOCK DIAGRAM FROM PCIE GEN 3 BASE SPECIFICATION 
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FIGURE 12. RX STRESSED VOLTAGE EYE LIMITS FROM PCIE GEN 3 BASE SPECIFICATION 

Eye width and eye height are evaluated at TP2P after applying post processing. Both CTLE and 

DFE are applied when calibrating the long channel, and only CTLE for the medium and short 

channels calibration channels.  

Eye height is determined by tuning the differential noise to meet the target VRX-SV-8G value. If this 

method is not able to maintain a sufficient eye width, less differential noise can be injected and 

the generator launch voltage can be adjusted. 
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Seasim application is used to post process the receiver eye at TP2P. This involves providing RJ, SJ, 

and DM-SI sources to Seasim, while combining CM-SI with clk/256 pattern source from BERT and 
captured in scope.  

A sample of eye opening diagram simulated by Seasim is shown below. 

 

FIGURE 13. SEASIM SIMULATED EYE DIAGRAM EXAMPLE 

 

5.2.2 Stressed Jitter Calibration (For Long Channel Only @PCIe3-Base Rx Specs) 

The stressed jitter eye calibration only applies for the long calibration channel (-20 dB) as per the 

PCIe3-Base Rx specifications, which is also performed similarly to the stressed voltage eye 
calibration and using the same post processing scripts. Eye width is determined by adjusting the 

RJ source, while eye height can be obtained by adjusting the generator launch voltage. 
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FIGURE 14. RX STRESSED JITTER EYE CALIBRATION BLOCK DIAGRAM FROM PCIE GEN 3 BASE SPECIFICATION 

 
FIGURE 15. RX STRESSED JITTER EYE LIMITS FROM PCIE GEN 3 BASE SPECIFICATION 

The calibration setups as described in the following sections will use the Anritsu BERT and 

appropriate accessories to provide the necessary test patterns with jitter, ISI, crosstalk, and 

transmitter equalization. 
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When calibration is completed, the GRL software will generate a test report detailing all results 

obtained from the calibration. 

5.3 Set Up Automated Rx Calibration for TP1 

Once pre-configuration has been completed from previous section, continue with the following 

calibration setup at TP1 (output of the BERT generator) using a GRL automation control enabled 
oscilloscope and MP1900A BERT. 

 

FIGURE 16. RECOMMENDED SETUP FOR TP1 RX CALIBRATION  

1. Using a SMA-SMA short cable, connect the MU181000A/B clock output to the MU181500B Ext 

clock input. 
2. Using a SMA-SMA short cable, connect the MU181500B jittered clock output to the 

MU195020A/MU196020A Ext clock input. 

3. Using coaxial cables, connect the MU195020A/MU196020A data outputs to the MU195050A 
data inputs. 

4. Using phase matched K-K coaxial cables, connect the MU195050A data outputs to Channels 1 

and 3 on the oscilloscope. 

 

5.4 Set Up Automated Rx Calibration for TP2 

The next step is to calibrate the TP1-TP2 Channel (output of the breakout channel length) with the 

following calibration setup using a GRL automation control enabled oscilloscope, MP1900A BERT, 
and variable ISI source (with CEM connector and replica trace). 
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FIGURE 17. RECOMMENDED SETUP FOR TP2 CHANNEL RX CALIBRATION 

1. Using back the same BERT connections from the TP1 calibration, disconnect the MU195050A 

data outputs from the oscilloscope channels.  
2. Using BNC-SMA cables, connect the MU181000A/B Ext I_Ext Q to the MU181500B I_Q output. 

3. Connect the MU195050A data outputs to the variable ISI board (with CEM connector and 

replica trace). 
4. Connect the variable ISI board to Channels 1 and 3 on the oscilloscope. 

5.5 Set Up Calibration Requirements 

After setting up the physical equipment, select  from the GRL PCIe 3.0 Base Rx Test Application 

menu to access the Setup Configuration page. Use this page to configure the necessary 

measurement-related settings prior to running calibration. 

5.5.1 ISI Generator Tab 

Select the type of supported ISI generators to be used: 

• “None”: This is the recommended method which is used to provide -18 dB physical 

channel Insertion Loss for calibration and testing. A PCIe 3.0 CEM Fixture can be used in the 
setup for this method. 

• “Artek”: This is provided as an Option. The Artek CLE1000-S2 ISI channel and an additional 

ISI board can be used in the setup for ISI automation. (Also see Appendix for more 

information on installing the Artek CLE Series.) 

The ISI Generator will be used for both calibration and testing. 
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FIGURE 18. SELECT ISI GENERATOR 

If the Artek CLE1000-A2 is being used, take note that the insertion loss specification of the 

CLE1000-A2 does not meet the PCI Express 3.0 Base Specification Requirement of -18 dB from 500 

MHz to 5 GHz. Refer to Appendix B, Section 10.3: Return Loss Limitations of the Artek CLE1000-A2 

for more information. 

5.5.2 Seasim Settings Tab 

Set up the Seasim parameters if using the Rx Behavioral package during Eye Height and Eye Width 

calibration. Also set the intrinsic jitter (if required) to be used in the Seasim calculation. 

 
FIGURE 19. CONFIGURE SEASIM 

5.5.3 Preset Setting Tab 

Select a pre-defined preset to be used, or select the checkbox to use a custom preset. If using a 

custom preset, enter the Pre-shoot and De-emphasis values for the preset. 
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FIGURE 20. CONFIGURE PRESET 

5.5.4 SSC Settings Tab 

Select ‘True’ to enable Spread Spectrum Clock (SSC) capabilities for calibration and receiver 

testing (if supported by the DUT) for informative purpose. Set the Frequency and Deviation values 
for SSC. 

  

FIGURE 21. SET UP SSC 

5.6 Select PCIe Gen 3 Base Rx Calibration 

After setting up the calibration requirements, access the Select Tests page on the left panel to 

select available Rx calibration. Select the check boxes of the respective calibration to be 

performed. 
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FIGURE 22. SELECT RX CALIBRATION 

[Note: The calibration list can be toggled as per PCIe3-Base & PCIe4-Base (8 GT/s) Rx specs using the 

Test Methodology selection field in the Configurations  page. See Section 5.7 for details.]  

5.6.1 Select to Perform TP1 Calibration 

At TP1, select to calibrate for BERT de-emphasis and pre-shoot (which form a linear curve fit), 

launch amplitude, random jitter (RJ), and sinusoidal jitter (SJ) (for PCIe Gen 3 frequencies as per 

PCIe3-Base & PCIe4-Base (8 GT/s) Rx specs and forms a linear curve fit for each SJ frequency).  

The GRL software will automatically run the selected calibration when initiated. 

 

FIGURE 23. SELECT TP1 CALIBRATION 

5.6.2 Select to Perform TP2-TP2P Channel Calibration  

At TP2-TP2P, select to calibrate for channel insertion loss, differential mode (DM) and AC common 
mode (CM) SI, and final stressed voltage/jitter eye to achieve calibrated eye height and width to 

produce a final stressed eye diagram for all calibration/breakout channel combinations. 

The GRL software will automatically run the selected calibration when initiated. 
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FIGURE 24. SELECT TP2-TP2P CALIBRATION (FOR PCIE3-BASE (8 GT/S) RX SPECS) 

 

FIGURE 25. SELECT TP2-TP2P CALIBRATION (FOR PCIE4-BASE (8 GT/S) RX SPECS) 

5.7 Configure Rx Calibration Parameters 

Select  from the menu to access the Configurations page. Set the parameters to be applied for 

calibration as described below. 

To return all parameters to their default values, select the ‘Set Default’ button. 

 

FIGURE 26. RX CALIBRATION CONFIGURATION PAGE 
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TABLE 4. RX CALIBRATION PARAMETER DESCRIPTION 

Parameter Description 

Test Methodology Select the PCIe3-Base or PCIe4-Base (8 GT/s) Rx specs to be 

applied for calibration.  

[Note: This will cause the Rx calibration list to change as per the 

selected PCIe-Base specs.]  

Gen4 Stress Cal RjRms 

(ps) 

For the PCIe4-Base (8 GT/s) Rx specs, enter the RJ (rms) value for 

the stress jitter calibration. 

5.8 Run Automation Calibration 

Once calibration have been selected and set up from the previous sections, the calibration are 

ready to be run.  

Select  from the menu to access the Run Tests page. The GRL-PCIE4-BASE-RXA software 

automatically runs the selected calibration when initiated. 

Before running the calibration, select the option to: 

• Skip Test if Result Exists ‒ If results from previous calibration exist, the software will skip 

those calibration. 

• Replace if Result Exists ‒ If results from previous calibration exist, the software will 
replace those calibration with new results. 

 

FIGURE 27. RUN TESTS PAGE 

Select the Run Tests button to start running the selected calibration. The connection diagram for 

the calibration being run will initially appear to allow the user to make sure that the calibration 

environment has been properly set up before calibration can proceed. Below shows an example of 
the connection diagram pop-up for the TP1 calibration. 
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FIGURE 28. EXAMPLE CONNECTION POP-UP DIAGRAM FOR TP1 CALIBRATION 
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6 Testing Using GRL-PCIE4-BASE-RXA 

The GRL-PCIE4-BASE-RXA test solution supports automated Rx compliance testing as well as 
optional margin tolerance testing for PCIe Gen 3 base receivers at 8.0 GT/s. Receiver compliance is 

tested for stress tolerance with and without the effect of breakout channel length at 8.0 GT/s. 

Receiver margin tolerance is an optional test which measures the stress margins with and without 
applying trace length. 

Receiver device compliance ensures the receiver DUT is able to correctly interpret data from a 

received signal with valid voltage and timing characteristics by achieving an acceptable bit error 
ratio (BER) of less than 1E-12. The signal used for verifying receiver tolerance must contain the 

maximum allowable jitter, noise, and signal loss. The stressed receiver tolerance test should 

include various differential mode sinusoidal interference, minimum transmitter voltage 

amplitude, and jitter which includes random jitter and a sinusoidal periodic jitter component that 
is swept across specific frequency intervals.  

Once the stressed receiver tolerance test setup has been calibrated, the BERT will transmit a 

modified compliance pattern to the receiver and monitors the loopback pattern has a BER that is 
less than 1E-12 with a confidence level of 95%. 

When testing is completed, the GRL software will generate a test report detailing all results 

obtained from the test runs. 

6.1 Stressed Voltage Receiver Test 

Once eye height and eye width have been calibrated, the Rx DUT will be connected to the far end 

of calibration channel for testing. Optimization for the transmitter equalization will then be 

performed in a similar way as for the stressed voltage eye calibration (equalization must also be 
optimized for the Rx DUT as well). SJ will be set to an initial value that allows the receiver CDR to 

achieve lock. 

 

FIGURE 29. RX DUT STRESSED VOLTAGE TEST BLOCK DIAGRAM FROM PCIE GEN 3 BASE SPECIFICATION 
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6.2 Stressed Jitter Receiver Test (For Long Channel Only @PCIe3-Base Rx 

Specs) 

The stressed jitter receiver test only applies for the long channel as per the PCIe3-Base Rx specs. 

Once eye height and eye width have been calibrated, the Rx DUT will be connected to the far end 

of the long calibration channel for testing. Optimization for the transmitter equalization will then 
be performed in a similar way as for the stressed voltage eye calibration (equalization must also 

be optimized for the Rx DUT as well). SJ will be set to an initial value that allows the receiver CDR 

to achieve lock which will then be swept over the frequency range as shown below, while 

maintaining fixed Tx equalization. The DUT must achieve a compliance BER of 1E-12 or lower for 
the entire swept SJ range. 

 

FIGURE 30. RX DUT STRESSED JITTER TEST SWEPT SJ MASK FROM PCIE GEN 3 BASE SPECIFICATION 

6.3 Set Up Automated DUT Rx Compliance Test 

Once calibration has been completed from Section 5, continue with the following test setups for 
DUT Rx compliance using the MP1900A BERT (including the MU195040A SI Error Detector) and 

variable ISI (for Short and Long Channels only). 

6.3.1 Connect Equipment for No Breakout Channel Length Effect 

The following setup is used to test the Rx DUT for ‘None’ channel stressed voltage compliance. 
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FIGURE 31. RECOMMENDED SETUP FOR DUT RX COMPLIANCE TESTING (NONE CHANNEL)  

1. Using back the same BERT connections from calibration, connect the MU195050A data 

outputs to the DUT Rx inputs. 

2. Using phase matched K-K coaxial cables, connect the DUT Tx outputs to the MU195040A (or 
MU196040B if using a PAM4 Error Detector) data inputs for loopback error detection. 

6.3.2 Connect Equipment for Short/Long Breakout Channel Length Effect 

The following setup is used to test the Rx DUT for Short/Long channel stressed voltage 
compliance as well as for Long channel stressed jitter compliance. 
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FIGURE 32. RECOMMENDED SETUP FOR DUT RX COMPLIANCE TESTING (SHORT/LONG CHANNEL)  

1. Using back the same BERT connections from calibration, connect the MU195050A data 

outputs to the variable ISI board. 

2. Using coaxial cables, connect the variable ISI board to the DUT Rx inputs. 
3. Using phase matched K-K coaxial cables, connect the DUT Tx outputs to the MU195040A (or 

MU196040B if using a PAM4 Error Detector) data inputs for loopback error detection. 

6.4 Set Up Test Requirements 

After setting up the physical equipment, select  from the GRL PCIe 3.0 Base Rx Test Application 

menu to access the Setup Configuration page. Use this page to configure the necessary 
measurement-related settings prior to running DUT tests. 

6.4.1 Error Counter Tab 

Select the DUT receiver base loopback capability for error detection. If the DUT can be configured 

for the loopback mode, select ‘LoopBack’, or otherwise select ‘Manual’. 

 

http://www.graniteriverlabs.com/


                                                                                                                                                                                 graniteriverlabs.com 

 

GRL PCIe3-BASE & PCIe4-BASE (8 GT/s) User Guide & MOI         Rev 2.5   

© Granite River Labs 2022                        Version 2.5, Sept 2022. Updated 9.22.2022 Page 40 of 75 

FIGURE 33. SELECT ERROR DETECTION MODE 

6.4.2 Loopback Mode 

If the ‘LoopBack’ mode has been selected from the Error Counter tab, then select ‘Clock Recovery’ 

in the Clock Recovery Method drop-down and set the clock recovery loop bandwidth. Other 

options on the Clock Recovery Method drop-down are not yet supported. 

Optionally, a user-defined test pattern can also be used for error detection by selecting the 
‘Custom Pattern for Error Detector’ checkbox. Then, select a supported pattern type to be used 

from the ED Pattern drop down field. If the checkbox is not selected, the default test pattern will 

be used. 

 

FIGURE 34. SET UP LOOPBACK TESTING 

6.4.3 Compliance Tab 

Set the target BER and Maximum Error limits allowed for compliance during testing. By default, 
the existing field values are based on Specification defined limits, however other values can also 

be set as required.  

Note: The syntax ‘1e-12’ indicates 1x10-12, and is the only syntax supported in this field. 

 

FIGURE 35. SET COMPLIANCE BER AND MAXIMUM ERROR LIMITS 
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6.4.4 Margin Search Parameters Tab 

Set the target compliance BER, maximum error, step size, and maximum number of steps to be 
used when running optional margin tolerance tests. 

 

FIGURE 36. SET UP MARGIN SEARCH TEST 

6.4.5 SSC Settings Tab 

Select ‘True’ to enable Spread Spectrum Clock (SSC) capabilities for receiver testing (if supported 
by the DUT) for informative purpose. Set the Frequency and Deviation values for SSC. 

  

FIGURE 37. SET UP SSC 

6.5 Select PCIe Gen 3 Base Rx DUT Tests 

After setting up test requirements, access the Select Tests page on the left panel to select 

available Rx tests for the DUT. Select the check boxes of the respective tests to be run. 

Note: When running tests for the first time or changing anything in the setup, it is suggested to 
perform calibration first. If calibration is not completed, attempting to run the Rx tests will produce 

errors. 
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FIGURE 38. SELECT RX DUT TESTS 

[Note: The test list can be toggled as per PCIe3-Base & PCIe4-Base (8 GT/s) Rx specs using the Test 

Methodology selection field in the Configurations  page. See Section 5.7 for details.] 

6.5.1 Select to Run Rx DUT Compliance Test  

Select ‘Receiver Compliance Test’ to test the DUT for compliance with the PCIe3-Base & PCIe4-

Base (8 GT/s) stress tolerance specs for all breakout channel lengths. Individual tests can also be 
selected to be performed as required. 

The GRL software will automatically run the test sequence when initiated. 

 

FIGURE 39. SELECT RX COMPLIANCE TEST (FOR PCIE3-BASE (8 GT/S) RX SPECS) 

 

FIGURE 40. SELECT RX COMPLIANCE TEST (FOR PCIE4-BASE (8 GT/S) RX SPECS) 

6.5.2 Select to Run Rx Margin Tolerance Test  

Select ‘Receiver Margin Tolerance Test’ to perform an optional test to conduct a stressed margin 

search for jitter tolerance for all breakout channel lengths. Individual tests can also be selected to 

be performed as required.  

The GRL software will automatically run the selected test when initiated. 
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FIGURE 41. SELECT RX MARGIN TOLERANCE TEST (FOR PCIE3-BASE (8 GT/S) RX SPECS) 

 

FIGURE 42. SELECT RX MARGIN TOLERANCE TEST (FOR PCIE4-BASE (8 GT/S) RX SPECS) 

6.6 Configure Receiver Compliance Test Parameters 

Select  from the menu to access the Configurations page. Set the required parameters for DUT 

Rx testing as described below. 

To return all parameters to their default values, select the ‘Set Default’ button. 

 

FIGURE 43. RECEIVER TEST PARAMETERS CONFIGURATION PAGE 

TABLE 5. RECEIVER TEST PARAMETERS DESCRIPTION 

Parameter Description 

Error Detector Type Select the PAM4 or NRZ error detector to be used for DUT testing. Note: The 

MU196040B error detector module supports PAM4 BER measurements. 

6.7 Configure Margin Tolerance Test Parameters 

If the Rx margin tolerance tests are selected to be performed, select  from the menu to access 

the Configurations page. Set the necessary margin test parameters for each SJ frequency as 

described below. 

To return all parameters to their default values, select the ‘Set Default’ button. 
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FIGURE 44. MARGIN TEST CONFIGURATION PAGE 

TABLE 6. TEST PARAMETERS DESCRIPTION 

Parameter Description 

SJ# Margin Test Settings 

– Base Value (ps) 

Set the duration in picoseconds for running margin search tests for 

each respective SJ margin. 

SJ# Margin Test Settings 

– Step Size (%) 

Set the step size in percentage for stepping through each respective 

SJ margin when running margin search tests. 

SJ# Margin Test Settings 

– Max Steps 

Set the maximum number of steps for stepping through each 

respective SJ margin during margin search tests. 

6.8 Enable Loopback BER Test 

To set up the GRL software to automate loopback testing for error detection, go to the 

Configurations    page and set up the following settings. Make sure that the Rx DUT is capable of 

supporting loopback mechanism for BER measurements. 

1. Under the Error Counter tab, select ‘LoopBack’ to enable loopback test mode for the DUT. 
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FIGURE 45. SELECT BER LOOPBACK TEST METHOD 

2. Under the LoopBack Mode tab, select ‘Clock Recovery’ in the Clock Recovery Method field to 

apply the clock data recovery function to process the modified compliance pattern generated 

by the DUT. 

If using a user-defined pattern instead of the default test pattern for error checking, select the 

‘Custom Pattern for Error Detector’ checkbox. Then, select a supported custom test pattern 

from the ED Pattern drop down field to be used.  

 

FIGURE 46. SET UP LOOPBACK TEST 

3. If necessary to change the default spec-defined limits for the target BER and maximum error 

allowed for BER measurements, then select the Compliance tab and enter new values. 

 

FIGURE 47. SET BER/ERROR LIMITS 

http://www.graniteriverlabs.com/


                                                                                                                                                                                 graniteriverlabs.com 

 

GRL PCIe3-BASE & PCIe4-BASE (8 GT/s) User Guide & MOI         Rev 2.5   

© Granite River Labs 2022                        Version 2.5, Sept 2022. Updated 9.22.2022 Page 46 of 75 

6.9 Run Automation Tests 

Once tests have been selected and set up from the previous sections, the tests are now ready to 
be run for the DUT.  

Select         from the menu to access the Run Tests page. The GRL-PCIE4-BASE-RXA software 

automatically runs the selected tests when initiated. 

Before running the tests, select the option to: 

• Skip Test if Result Exists ‒ If results from previous tests exist, the software will skip those 

tests. 

• Replace if Result Exists ‒ If results from previous tests exist, the software will replace 

those tests with new results. 

 

FIGURE 48. RUN TESTS PAGE 

Select the Run Tests button to start running the selected tests. The connection diagram for the 

test being run will initially appear to allow the user to make sure that the test environment has 

been properly set up before testing can proceed. Below shows an example of the connection 

diagram pop-up for the Rx DUT compliance test. 
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FIGURE 49. EXAMPLE CONNECTION POP-UP DIAGRAM FOR RX COMPLIANCE TEST 
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7 Interpreting GRL-PCIE4-BASE-RXA Test Report 

When all calibration and test runs have completed from the previous section, the GRL-PCIE4-
BASE-RXA software will automatically display the results on the Report page.  

Select        from the menu to access the Report page for a quick view of all results.  

If some of the results are not desired, they can be individually deleted by selecting the Delete 
button.  

For detailed test report, select the Generate report button to generate a PDF report. To have the 

calibration data plotted in the report, select the Plot Calibration Data checkbox. 

 
FIGURE 50. TEST REPORT PAGE 

7.1 Understand Test Report Information 

This section gives a general overview of the test report to help users familiarize themselves with 

the format. Select the Generate report button to generate the test report. 
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7.1.1 Test Session Information 

This portion displays the information previously entered on the Session Info page. 

 

FIGURE 51. TEST SESSION INFORMATION EXAMPLE 

7.1.2 Test Summary Table 

This table provides an overall view of all the calibration and tests performed along with their 

conditions and results. 

 

FIGURE 52. TEST SUMMARY TABLE EXAMPLE 
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7.1.3 Test Results  

This portion displays the results in detail along with supporting data points and screenshots for 
each calibration/test run. 
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FIGURE 53. TEST RESULTS EXAMPLE 

7.2 Delete Test Results 

To individually delete any unwanted calibration/test results, select the corresponding result row 

and Delete button. 

To entirely remove all existing calibration/test results, select the Delete All button. 

 

FIGURE 54. DELETE TEST RESULTS 
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8 Saving and Loading GRL-PCIE4-BASE-RXA Test Sessions 

The usage model for the GRL-PCIE4-BASE-RXA software is that the test results are created and 
maintained as a ‘Live Session’ in the application. This allows the user to quit the application and 

return later to continue where the user left off.   

Save and Load Sessions are used to save a test session that the user may want to recall later. The 
user can ‘switch’ between different sessions by saving and loading them when needed.  

• To save a test session, with all of the test parameter information, test results, and any 

waveforms, select the Options drop-down menu and then select ‘Save Session’. 

• To load a test session back into the application, including the saved test parameter settings, 
select Options → ‘Load Session’. 

• To create a new test session and return the application back to the default configuration, 

select Options → ‘New Session’. 

 

FIGURE 55. SAVE/LOAD/CREATE TEST SESSIONS 

The test configuration and session results are saved in a file with the ‘.ses’ extension, which is a 

compressed zip-style file, containing a variety of information. 
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9 Appendix A: Method of Implementation (MOI) Using 

Automation 

This section provides sample methodology to automate PCIe Gen 3 Base Rx calibration using GRL-

PCIE4-BASE-RXA software at 8 GT/s. This procedure will ensure Receiver Impairment adjustments 

on the BERT are accurate before running DUT compliance tests. 

9.1 Perform Calibration at TP1 

9.1.1 Pre-shoot Calibration 

Pre-shoot is calibrated for target dB of 3.5 for each preset for different trace lengths of the 
breakout board. The Caltable method is used to calibrate pre-shoot: 

1. Set 800 mV (p-p) amplitude on BERT. 

2. Disable all stresses (RJ, SJ, etc.) 
3. Set 0 dB for De-emphasis. 

4. Measure: 

1 dB, then measure pre-shoot, record 
2 dB, measure again, record 

….. 

4 dB, measure again, record. 

5. Plot a Caltable graph.  
6. Passing criteria is to obtain measured pre-shoot at 3.5 dB. 

9.1.2 De-emphasis Calibration 

De-emphasis is calibrated for target dB of -6.0 for each preset for different trace lengths of the 
breakout board. The Caltable method is used to calibrate de-emphasis: 

1. Set 800 mV (p-p) amplitude on BERT. 

2. Disable all stresses (RJ, SJ, etc.) 
3. Set 0 dB for Pre-shoot. 

4. Measure: 

-8 dB, then measure de-emphasis, record 

-7 dB, measure again, record 
-6 dB, measure again, record 

….. 

0 dB. 

5. Plot a Caltable graph. 

6. Passing criteria is to obtain measured de-emphasis at -6 dB. 

http://www.graniteriverlabs.com/


                                                                                                                                                                                 graniteriverlabs.com 

 

GRL PCIe3-BASE & PCIe4-BASE (8 GT/s) User Guide & MOI         Rev 2.5   

© Granite River Labs 2022                        Version 2.5, Sept 2022. Updated 9.22.2022 Page 55 of 75 

 

FIGURE 56. DE-EMPHASIS CALIBRATION CALTABLE GRAPH 

9.1.3 Launch Amplitude Calibration 

Launch amplitude is calibrated for target minimum peak-to-peak amplitude of 800 mVpp. The 

Caltable method is used to calibrate launch amplitude: 

1. Initialize BERT. 

2. Set to 0 dB Pre-shoot and De-emphasis obtained from Caltable as measured above. 
3. Set 300 mV Amplitude on BERT, then measure the amplitude in scope, record it. 

4. Increase 100 mV on each iteration, measure the amplitude on scope, until measured 

amplitude meets or exceeds 1300 mV. 
5. Plot a Caltable graph.  

6. Passing criteria is to obtain MEAN value of amplitude measurement at 800 mV. 

9.1.4 RJ Calibration 

Random jitter (RJ) is calibrated for target value of 2 to max 3 ps (RMS). The Caltable method is 

used to calibrate RJ: 

1. Initialize BERT. 

2. Set 800 mV (p-p) amplitude (based on calibrated value). 
3. Set to 0 dB Pre-shoot and De-emphasis obtained from Caltable as measured above. 

4. Set all stresses to 0 mV. 

5. Set Clock Pattern 1100 on BERT. 
6. Set Initial RJ value to 0.04 UI(p-p) on BERT. 

7. Measure RJ (in ps (RMS)) from scope using EZJIT, record the measured value. 
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8. Increase 0.1 UI (p-p) on each iteration, measure RJ from scope, until measured RJ meets or 

exceeds 3 ps (RMS). 
9. Plot a Caltable graph.  

10. Passing criteria is to obtain measured RJ at Min 2 ps (RMS) and Max 3 ps (RMS).  

9.1.5 SJ Calibration 

Sinusoidal Jitter (SJ) is calibrated (with Clock pattern 1100) for four SJ frequencies: 30 kHz, 1 MHz, 

10 MHz and 100 MHz. 

Stressed Voltage Test: 

 

Stressed Jitter Test: 

 

The Stressed Jitter test requires the test to pass each and every frequency, with its respective SJ 

amplitude at 30 kHz, 1 MHz, 10 MHz, and 100 MHz. 

 

FIGURE 57. SWEEP JITTER RANGE AND MASK 

The Caltable method is used to calibrate SJ: 

1. Initialize BERT. 

2. Set 800 mV (p-p) amplitude (based on calibrated value).  

3. Set to 0 dB Pre-shoot and De-emphasis obtained from Caltable as measured above. 
4. Set all stresses to 0 mV. 

5. Set Clock Pattern 1100 on BERT. 

6. Set the SJ Frequency of the first Permutation (30 kHz, 1 MHz, 10 MHz, 100 MHz). 
7. Set 0 (%UI (p-p)) as base value in SJ, measure SJ (in ps (p-p)) from scope using EJZIT, record. 
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8. Increase 0.1 UI (p-p) on each iteration for SJ Frequency 1 MHz, 10 MHz, 100 MHz; Increase 0.2 

UI (p-p) on each iteration for SJ Frequency 30 kHz. 
9. Measure SJ from scope until measured SJ meets or exceeds 62.5 ps for 30 kHz SJ Frequency or 

20.0 ps for SJ Frequency 100 kHz, 1 MHz, 100 MHz. 

10. Plot a Caltable graph.  

11. Passing criteria is to obtain measured SJ at Min 6 ps (p-p) and Max 62.5 ps (p-p) for 30 kHz, 20.0 
ps (p-p) for 100 kHz, 1 MHz, 100 MHz.   

12. Proceed to next permutation. 

9.2 Perform Calibration at TP2 

Calibration at TP2 is performed for the None, Short or Long breakout calibration channels. 

9.2.1 Insertion Loss Calibration 

1. Initialize BERT. 
2. Set 800 mV (p-p) amplitude (based on calibrated value). 

3. Set to 0 dB Pre-shoot and De-emphasis obtained from Caltable as measured above. 

4. Set all stresses to 0 mV. 
5. Set Clk/256 Pattern on BERT. 

6. Set ISI % on Artek to 0.0 (if long, set 15%). 

7. Trigger waveform on scope to display waveform. 

8. Save waveform as .dat file (Y only). 

9. Convert saved waveform to Seasim-compatible waveform (step response) with X component 

(start from 0). Save to xxx_vict.rfstep1. The _vict.rfstep1 format consists of 

time[SPACE]Voltage_level[New Line]. 
10. Create Seasim config file with predefined values for IL calculation. 

11. Run Seasim with config file and step response. 

12. Obtain .log file and .csv file from Seasim. 
13. Read insertion plot from .csv. Check against upper and lower limit of specifications. 

14. Use GRL script to plot output of insertion loss curve with specifications. 

15. If failed, loop, increase 1% on Artek. Repeat insertion loss measurement. 

16. Passing criteria is to ensure that 60% of the curve is within the upper and lower limits for the 
respective channel type. 

Below shows a sample graph output by Seasim indicating insertion loss of -9dB at 4 GHz. 
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9.2.1.1 Example Insertion Loss Results 

 

FIGURE 58. SPECIFICATION MASK 
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FIGURE 59. INSERTION LOSS AT 27.5% ISI (-16.9 DB) 

 

FIGURE 60. INSERTION LOSS AT 30% ISI (-17.9 DB) 
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FIGURE 61. INSERTION LOSS AT 32.5% ISI (-18.9 DB) WITHIN TARGET 

 

FIGURE 62. INSERTION LOSS CALIBRATION FOR LONG CHANNEL – IL FALLS BETWEEN REQUIRED MASK 

9.2.2 AC Common Mode (CM) Sinusoidal Interference Calibration 

The Caltable method is used to calibrate CM-SI: 

1. Initialize BERT. 

2. Set 0 mV (p-p) amplitude. 
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3. Set to 0 dB Pre-shoot and De-emphasis obtained from Caltable as measured above. 

4. Set all stresses to 0 mV. 
5. Set Frequency for Common Mode to 120 MHz. 

6. Set Output for Common Mode to 7 dBm, turn On Output. 

7. Turn Off Output for Differential Mode. 

8. Initialize scope. 
9. Set up Func1 on scope to (Chan1 + Chan2)/2. 

10. Measure Vp-p on Func1. 

11. Increase Phase for Common Mode by 10%, measure Vp-p on scope until Max value. 
12. Record measured Phase. 

13. Set 800 mV (p-p) amplitude (based on calibrated value).  

14. Set All Zero Pattern on BERT. 
15. Set ISI % value based on above calibrated data. 

16. Set Common Mode to Sine Wave. 

17. Set -5 dBm as base value. 

18. Measure Amplitude (in mV) from scope, record. 
19. Increase 0.174 dBm on each iteration, measure Amplitude from scope until measured value 

meets 150 mV (for Long Channel). 

20. Plot a Caltable graph.  
21. Passing criteria is to obtain measured CM-SI at 150 mV for Long Channel or 250 mV for Short 

and None Channel. 

9.2.3 Differential Mode (DM) Sinusoidal Interference Calibration 

This calibration ensures that the waveform achieves the calibrated eye height. The Caltable 

method is used to calibrate DM-SI: 

1. Initialize BERT. 

2. Set 0 mV (p-p) amplitude. 
3. Set to 0 dB Pre-shoot and De-emphasis obtained from Caltable as measured above. 

4. Set all stresses to 0 mV. 

5. Set Frequency for Differential Mode to 2.1 GHz. 
6. Set Output for Differential Mode to 7 dBm, turn On Output. 

7. Turn Off Output for Common Mode. 

8. Initialize scope. 
9. Set up Func1 on scope to (Chan1 – Chan3). 

10. Measure Vp-p on Func1. 

11. Increase Phase for Differential Mode by 10%, measure Vp-p on scope until Max value. 

12. Record measured Phase. 
13. Set 800 mV (p-p) amplitude (based on calibrated value). 

14. Set All Zero Pattern on BERT. 

15. Set ISI % value based on above calibrated data. 
16. Set 0.89 dBm as base value (Differential Mode). 
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17. Measure Amplitude (in mV) from scope, record. 

18. Increase 0.174 dBm on each iteration, measure Amplitude from scope until measured value 
meets or exceeds 14 mV. 

19. Plot a Caltable graph.  

20. Passing criteria is to obtain measured DM-SI at 14 mVpp or greater. 

9.3 Perform Calibration at TP2P 

9.3.1 Stress Jitter Voltage Eye Calibration  

This calibration verifies that the waveform achieves the calibrated eye width and eye height. 

Seasim is used to post process the receiver eye at TP2P, where RJ, SJ, and DM-SI sources are input 
to Seasim while CM-SI is combined with clk/256 pattern source from BERT and captured in scope. 

1. Initialize BERT. 

2. Set 800 mV (p-p) amplitude (based on calibrated value). 
3. Set to 0 dB Pre-shoot and De-emphasis obtained from Caltable as measured above (for the 

Short and None channels). Use “Preset 7” values for the Long channel. 

4. Set all stresses to 0 mV. 
5. Set Clk/256 Pattern on BERT. 

6. Set Artek to calibrated ISI %. 

7. Trigger waveform on scope to display waveform. 

8. Save waveform as .dat (Y only). 

9. Convert saved waveform to Seasim-compatible waveform (step response) with X component 

(starting from 0). Save to xxx_vict.rfstep1. The _vict.rfstep1 format consists of 

time[SPACE]Voltage_level[New Line]. 
10. Create Seasim config file with predefined values for Eye Opening Calculation, starting with 0 

mV DM-SI. 

11. Run Seasim with config file and step response. 
12. Obtain .log file from Seasim. 

13. Read eye height (EH) and eye width (EW). 

14. Record EH vs. DM, and EW vs. DM for 800 mV. 

15. Increase DM-SI (in Seasim config) to 5 mV, run Seasim again, obtain EH and EW. 
16. After obtained EH and EW from 0, 5, 10, 15, 20, 25 mV, plot Caltable graph.  

17. If EH and EW do not fall within 0.3 UI and 25 mV (for Long Channel), increase SJ by 0.1 UI. 

Repeat method to obtain EH and EW by adjusting DM. 
18. If EH and EW do not fall within 0.3 UI and 25 mV after SJ variation, adjust Amplitude and repeat 

method to obtain EH and EW. 

19. Repeat until EH and EW fall within specs for each channel type. 
20. Record measured Amplitude, SJ, and DM. 
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10 Appendix B: Artek CLE Model Series Installation 

10.1 ISI Generator Driver Installation 

If using a Artek CLE Model unit for Variable ISI Calibration, follow these steps to install the ISI 

generator driver before selecting it as an ISI channel in the GRL software. 

1. Connect the Artek unit to the PC being used as the controller using a USB 2.0 cable. 
2. Turn on the front panel power switch on the Artek unit. 

3. Right-click on My Computer > Manage > Device Manager. If no software for Artek has been 

installed, you will see a ‘bang’ in the Device Manager. 

 

FIGURE 63. DEVICE MANAGER WINDOW 

4. To install the Artek driver, go to http://www.aceunitech.com/support.html and download the 

Control Software package for the Artek CLE Series. 
5. Unzip the CLE Series Software folder and install the driver as follows: 

a) In Device Manager, right-click on CLExxxx > Update Driver. 

b) Select Browse My Computer for Driver from Windows dialog. See Figure 64. 
c) Browse to the root directory of the unzipped CLE Series Software folder. 

d) Click Next and then click Install to complete installation for the driver software. See Figure 

65. 
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Once installation has completed, the Device Manager window should look like the example in 

Figure 66. 

 

 

FIGURE 64. UPDATE DRIVER WINDOW 

 

 

FIGURE 65. WINDOWS SECURITY WINDOW AND CONFIRMATION WINDOW 
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FIGURE 66. DEVICE MANAGER WINDOW AFTER INSTALLATION 

The CLE Series software driver is now installed and the Artek unit can now be selected for use 

remotely using the GRL software. 

10.2 CLE Series User Interface (UI) Installation 

It may also be useful to install the CLE Series UI, so that the ISI channel can also be controlled 

manually from the computer. To install the UI, follow these steps: 

1. In the CLE Series Software folder, select and install the Setup.exe file. Upon successful 
installation, the following UI window will appear. 

2. Close this window if manual control is not required. 

 

FIGURE 67. CLE SERIES UI 

10.3 Return Loss Limitations of the Artek CLE1000-A2 

If using the Artek CLE1000-A2 for Insertion Loss, it should be understood that the Return Loss 

Specifications of the CLE1000 does not meet the specific requirements of the PCI Express 3.0 Base 

Specification. The return loss of the CLE1000 varies with the % of ISI that is provided. The 
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following two plots show the return loss of the CLE1000 at Channel lengths of 10% to 50%, which 

would be the typical range of a PCIe3 Calibrated Channel. 

 

FIGURE 68. CLE1000-A2 VARIABLE ISI GENERATOR IL, RL AT 0% SETTING 

 

FIGURE 69. CLE1000-A2 VARIABLE ISI GENERATOR IL, RL AT 50% SETTING  
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11 Appendix C: Connecting Keysight Oscilloscope to PC 

If using a Keysight oscilloscope, refer to the following procedure on how to connect the Scope to 
be used with a PC. The Keysight Scope can be connected to the PC through GPIB, USB, or LAN. 

1. Download the latest version of the Keysight IO Libraries Suite software from the Keysight 

website and install on the PC. 
2. When installed successfully, the IO icon (      ) will appear in the taskbar notification area of the 

PC. 

3. Select the IO icon to launch the Keysight Connection Expert. 
4. Click Rescan. 

 

FIGURE 70. KEYSIGHT CONNECTION EXPERT 

5. Refresh the system. The Keysight Scope is shown on the left pane and the VISA address is 

shown on the right pane. 
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FIGURE 71. OSCILLOSCOPE’S VISA ADDRESS 

6. When connecting the Keysight Scope to the PC through GPIB/USB, type in the VISA address 

into the ‘Address’ field on the Equipment Setup page of the GRL PCIe CEM 4.0 Rx Test 

Application. If connected via LAN, type in the Scope IP address, for example 

“TCPIP0::192.168.0.110::inst0::INSTR”. Note to omit the Port number from the address.  

If there is error in connection, type in the Scope IP address as 

“TCPIP0::192.168.0.4::5025::SOCKET”. 
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12 Appendix D: Connecting Tektronix Oscilloscope to PC 

If using a Tektronix DPOJET Series oscilloscope, refer to the following procedure on how to 
connect the Scope to be used with a PC. The Tektronix Scope can be connected to the PC through 

GPIB, USB, or LAN. 

1. Download the latest version of the Tektronix TekVISA software from the Tektronix website and 
install on the PC. 

2. When installed successfully, open the OpenChoice Instrument Manager application. 

 

FIGURE 72. OPENCHOICE INSTRUMENT MANAGER IN START MENU 

3. The left “Instruments” panel on the OpenChoice Instrument Manager will display all 

connected instruments. The functional buttons below the “Instruments” panel ‒ “Instrument 

List Update”, “Search Criteria”, “Instrument Identify” and “Properties” can be used to detect 

the Scope in case it does not initially appear under “Instruments”.  

a) “Instrument List Update”: Select to refresh the instrument list and locate new instruments 
connected to the PC.  

b) “Search Criteria”: Select to configure the instrument search function. 

c) “Instrument Identify”: Select to use a supported programming language to send a query to 

identify the selected instrument. 
d) “Properties”: Select to display and view the selected instrument properties. 

http://www.graniteriverlabs.com/


                                                                                                                                                                                 graniteriverlabs.com 

 

GRL PCIe3-BASE & PCIe4-BASE (8 GT/s) User Guide & MOI         Rev 2.5   

© Granite River Labs 2022                        Version 2.5, Sept 2022. Updated 9.22.2022 Page 70 of 75 

 

FIGURE 73. OPENCHOICE INSTRUMENT MANAGER MENU 

4. If connecting the Tektronix Scope to the PC via USB, select the “Search Criteria” function to 

ensure that USB connection is enabled, and then select the “Instrument List Update” function. 

When the Scope appears on the “Instruments” panel, select it and then go to the “Instrument 
Identify” function. This will display the model and serial number of the Scope once detected. 

Select the “Properties” function to view the Scope address. 

5. If connecting the Tektronix Scope to the PC via LAN, the Scope IP address must be pre-
determined beforehand. Then select the “Search Criteria” function to ensure that LAN 

connection is enabled and type in the Scope IP address. When the Scope shows up in the list, 

select it followed by “Search”. The Scope should then appear on the “Instruments” panel. 

Select it and access the “Instrument Identify” function to view the Scope model and serial 
number as well as the “Properties” function to view the Scope address. 

6. On the Equipment Setup page of the GRL PCIe 3.0 Base Rx Test Application, type in the Scope 

address into the ‘Address’ field. If the GRL PCIe 3.0 Base Rx Test Application is installed on the 
Tektronix Scope, ensure the Scope is connected via GPIB and type in the GPIB network 

address, for example “GPIB8::1::INSTR”. If the GRL software is installed on the PC to control 

the Scope, type in the Scope IP address, for example “TCPIP0::192.168.0.110::inst0::INSTR”. 

Note to omit the Port number from the address.  
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13 Appendix E: Scope and Cable De-skew 

Before beginning any test or data acquisition, the oscilloscope must be warmed, calibrated, and 
cables de-skewed. This section describes the procedure for calibrating the Oscilloscope, and de-

skewing the cables. 

The DSO/DSA and DSAX/DSOX series Oscilloscopes must be calibrated manually, and this is 
recommended after a 30- to 60-minute warm-up period. 

 

FIGURE 74. SCOPE DESKEW SETUP 

Perform the following steps, with reference to Figure 78. 

1. Select the File → Open → Setup… menu to open the Open Setup File window. 

2. Navigate to the directory location that contains the deskew setup file (.set). 

3. Select the deskew setup file by clicking on it. 

4. Click the Open button to configure the oscilloscope from this setup file. 
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FIGURE 75. OPEN SCOPE DE-SKEW SETUP FILE WINDOW 

 

FIGURE 76. SCOPE DE-SKEW SETUP FILE EXAMPLE 

An example of the oscilloscope display is shown in Figure 77. A rising edge of the square wave is 

shown in a 100ps/div horizontal scale. The upper portion of the screen shows channel 1 (yellow 

trace) and channel 3 (blue trace) superimposed on one another. The lower portion of the screen is 

the differential signal (white trace) of channel 1 minus channel 3. The top two traces provide for 
visual inspection of relative time skew between the two channels. The bottom trace provides for 

visual presentation of unwanted differential mode signal resulted from relative channel skew (and 

to a much lesser extent from other inevitable channel mismatch parameters like gain and non-
linearity). Figure below is an example of exaggerated skew between channel 1 and channel 3. 
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FIGURE 77. SCOPE DE-SKEW OSCILLOSCOPE DISPLAY   

Figure 78 shows the desired effect of no skew between the cables. Note that the channel 1 (yellow 

trace) and channel 3 (blue trace) traces overlap, and the differential signal (white trace) is flat. If 

this is not the case, then perform the following steps to reduce the skew between channels 1 and 
3. 

 

Skew between 

Ch1 and Ch3 

Differential signal not 

flat, indicating mismatch 

in skew 

Ch1 and Ch3 traces 

overlap, indicating no 

skew error 

Flat differential signal, 

indicating no skew error 
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FIGURE 78. SCOPE DE-SKEW OSCILLOSCOPE DISPLAY DE-SKEWED 

Referring to Figure 79 and Figure 80, perform the following steps to de-skew the channels: 

5. Click on the Setup → Channel 1… menu to open the Channel window. 

6. Move the Channel window to the left so you can see the traces. 

7. Adjust the Skew by clicking on the  or → arrows, to achieve the flattest response on the 
differential signal (white trace). 

8. Close the Channel window. 

9. The de-skew operation is now complete. 

10. Disconnect the cables from the Tee on the Aux Out BNC. Leave the cables connected to the 
Channel 1 and Channel 3 inputs. 

 

FIGURE 79. SCOPE DE-SKEW PROCESS – OPEN CHANNEL WINDOW 

 

FIGURE 80. SCOPE DE-SKEW PROCESS – ADJUST SKEW 
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